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Flatting Tutorial

First Off, make sure your tools are set up
properly.

The Four main tools you will use are:
Lasso, Bucket, Wand and Pencil.

Pencil

You’ll sometimes use the pencil tool to
touch up edges or fix things on flats. You
want all settings turned off for the pencil
tool, as shown below.
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You also want to make sure it’s set to
100% Opacity, and the Mode is set to Nor-
mal, as shown in the options bar below.

Brush: Mode: [ Normal 9‘ Opacity: [100% |

The Pencil tool is great for making quick
fixes, instead of selecting and filling areas.

Lasso

The Lasso tool is the main tool you’ll
use to make all the selections you’re going
to fill. You need to make sure you have the
right settings for it, otherwise all your work
will be for nothing.

‘ [ ] | Feather: [0 ox [ Anti-alias

Feather should be set to O (zero), and An-
ti-alias turned off. If either of these settings
is incorrect, you’re shooting yourself in the
foot.

Edges must be aliased in order for the
wand tool to work properly, otherwise it’s
going to skip areas that are Anti-aliased,
leaving funny little lines where different
colors meet at the edges of selections.

Wand

Tolerance should be set to O (zero), An-
ti-alias turned off, and Sample All Layers
turned off as well (not shown).
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Contiguous can be turned off, or on de-
pending on what you are doing. More on
Contiguous later - it’s an option that applies
to both the Wand and Bucket tools.

Bucket

The Bucket tool is what you will use to
fill all your selections with color.

Make sure Foreground is selected, Mode
is ‘Normal’, Opacity 100%, Tolerance 0
(zero), Anti-alias is off, Contiguous is off,
and All Layers is off.
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Contiguous Option

The Contiguous Option is a very cool fea-
ture that speeds things up tremendously.

When it is checked with the Wand , it will
only select colors that are adjacent to where
you select. If it is unchecked, it will select
the same color everywhere on the page,
even if it is not adjacent, or connected to the
color you select.

Below, you have something that looks
like a white flag with an orange strip down
the middle.

Clicking on the left half with the Wand
tool, and Contiguous checked, will result in
only the left side being selected (top left im-
age).

Turn off Contiguous, and click the left
side again, and both halves are now selected
(bottom left image).

The Bucket tool works similarly with
Contiguous. Turn Contiguous on, and click
the left side to fill with red, and only the left
side will fill (top right image). Undo, turn
Contiguous off, and click on the left side,
and anywhere there is white will be filled
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with red. (bottom right).

I generally work with Contiguous checked
for the Wand, and turned off for the Bucket
tool, but I'll often turn contiguous off and
on with the Wand to make sure I get all the
parts I need. It can be easy to miss one small
spot when selecting things one at a time with
the wand.

With the Bucket tool and the Contiguous
option it allows you to flat from foreground
to background without worrying about
missing or not filling in areas that are not
adjacent, and you can fill in different areas
in one selection with one click, even if they
are separated by areas of color.

When flatting, you always want all your
tools with Anti-alias turned off, and Toler-
ance or Feathering set to zero. You don’t
want any fuzzy or blurred edges separating
colors, otherwise you’re going to spend as
much time fixing the flats as it took you to
do them in the first place.

On to setting up your file and getting it
ready for flatting.
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Flatting Tutorial

Setting up your file for Flatting.

One thing you’ll do many times is prep-
ping a bitmap file for flatting. Rather than
repeat the same steps over and over again,
you can create an Action that will do it all
for you.

Start by opening your Actions Palette,
clicking the little arrow in the top right cor-
ner, and select ‘New Action...’
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New Set...

Duplicate
Delete
Play

Start Recording
Record Again...
Insert Menu ltem...
Insert Stop...
Insert Path

Name your Action, and hit ‘Record’.
New Action

Name: |Prep file for Flatting/Coloring | E—M—)

Set: [ Flatting Actions H-l
Function Key: [@ [1Shift | Command
Color: [ [ ] None Hll

Photoshop is now recording what you do
for this action.

In the Menu Bar, select Image, then Grey-
scale, as shown below.
m Layer Select Filter Analysis View

| _Mode > [T |
‘ Adjustments [ 2
Duotone .
Duplicate... Indexed Color |
Apply Image... RGB Color |
Calculations... | CMYK Color
Lab Color

It will ask you for a size ratio. Make sure
it is set to ‘1’, as shown below.

In your Channels Palette, select the Gray
channel, and drag it down to the ‘Duplicate’
icon as shown below. (The Duplicate icon
is the one to the left of the Trash can icon in
the bottom right of the Channels Palette)
-

=

J Channels * ]

5

Gray #1

Rename the new channel to ‘Lineart’.
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Select the ‘Gray’ Channel so it is high-
lighted as shown below.
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Next, you want to Select All in your main
document. You can use the Menubar (Select
-> All), or keyboard Shortcuts. 3-A on a
mac, or CTRL-A on a PC.
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Hit the ‘D’ Key - this sets your fore-
ground color to black, and background color
to white.

Hit the ‘X’ key, this switches your fore-
ground and background colors. White
should now be your foreground color, as
shown below.
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Fill with white (under the Menu Bar, Edit
-> Fill, or shift-F5, or hit Option-Delete).

You page should now be filled with white,
as shown below.
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In the Menu Bar, under Image -> Mode,
select RGB Color as shown.
JEFTN Layer Select Filter Analysis  View

Bitmap...
i Adjustments p  Grayscale
Duotone...
Duplicate... Indexed Color
Apply Image... RGB Color

In your Channels Palette, Double-Click
your Lineart channel. You’ll see a new dia-
log box open. Make sure the color is black,
and Opacity is set to 80%. Hit ‘OK”.

The reason you set the opacity to 80% is
S0 you can see where colors butt up under
the lineart. You want them to line up in the
middle where you can.

Channel Options

k)

Name: |Li neart

— Color Indicates:
() Masked Areas

{*) Selected Areas
() Spot Color

— Color

. Opacity: (80 | %

In your Actions Palette, hit the ‘Stop Re-
cord Button (the square one on the bottom
left of the palette).
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You now have an action that you can use
to do all this tedious work for you on the rest
of your files. You can set a keyboard short-
cut for this action, or create a Droplet.

Droplets are little files on your desktop
you can just drag files onto, and it will open
Photoshop and run the action on them.

Now you’re all set up to begin flatting a

page.
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Flatting Tutorial

I know this book is printed Full Bleed
(color goes right to the edge of the page),
so I fill the entire page with a background
color. If it had panels and gutters, I would
leave the gutters white, and fill each panel
with a background color (top left).

Next, I break out the individual panels us-
ing a different shade of blue than the main
background color (bottom right).

I start working on the first panel. I select
all the mountains using the Lasso tool, and
fill it with the Bucket tool. I work from large
to small areas. I don’t select each part of a
large object and fill with different colors, I
get the whole thing, fill, then break down
further.
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Flatting Tutorial

I select the shrubbery and fill with green.
I usually make all of the selections first, and
fill them all at once, as it eliminates extra
steps of selectand fill... select and fill... select
and fill... etc., saving more time in the long
run, and getting flats done faster (above).

I zoom in just enough to see all the details
I need when making selections. Don’t zoom
in too far - just enough to be able to clearly
see where things should be separated. Zoom
in too far and you’ll spend lots of time wait-
ing for the screen to scroll to new areas when
selecting with the Lasso tool.

Next I break out the mist in the lower
right corner of the panel (left).
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Flatting Tutorial

In the second panel, I break down the
mountains a little more - foreground, middle
ground, and far background.

However, | save a step by selecting the
middle-ground first. By selecting and fill-
ing it first, I’ve also separated the fore- and
background at the same time. If 1 had se-
lected the foreground part of the mountain
and filled it, I would still have to select the
middle ground!

Deciding how to break down a page/pan-
el/character is the key to fast flatting. With
practice, deciding where to break down flats
comes naturally, and quickly.

The more steps and needless selections
you eliminate, the faster you go.

I break down the two little buildings on
the mountain (top middle), then add snow to
the background mountain (bottom middle).

Next I break out the clouds as one big
mass (top right), and then pick out the indi-
vidual parts of the clouds with another color
(bottom right).

And that finishes off the first panel.
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Now, I pick out all the characters on the
page, selecting the entire character(s), and
filling with a solid color. People usually
have the most irregular outlines, and rather
than trying to select a background around
them, I just select the character first, then
fill them with a color.

The bottom right panel doesn’t have much
of a background, but the top right panel has
moderately complex background that runs

Flatting Tutorial

behind Lara. Selecting and filling her first
will make working on the backgrounds
much easier.

I always leave breaking down the char-
acters last, as that’s what usually goes the
fastest.

Backgrounds can be pretty time consum-
ing, so I like to get the boring stuff out of the
way first.
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Flatting Tutorial

Sometimes, instead of selecting an area
with the Lasso, I'll use the Wand tool,
then remove areas from that selection. In
the top left, I used the wand tool to select
the background, entered Quickmask mode
(hit the ‘Q’ key). I have Quickmask mode
channel options set to ‘Selected Areas’.

I fill the background with color. Next I se-
lect the distant building, following the lines

your Quickmask looks like the opposite of
your selection, double-click the Quickmask
channel, make sure it’s not set to ‘Masked
Areas.’

From there, I use the lasso tool to remove
the section of sky (shown above).

where they lead past Lara and to the right,
then fill with another color.

I pop out the win-
dows of that distant
building. Are they
lit up, or dark? Who
cares. Pop a color in
and move on!
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Breaking down the house.... Again, I try
to make selections that make my job easier
and faster. In panel 2, breaking out the top
strip and filling with color separates the up-
per roof for me as the same time. I’ll just

Flatting Tutorial

keep breaking it down, bit by bit until it’s all
separated out. Don’t bounce all around the
page, that’s how you miss things. Work on
one thing at a time, and break it all the way
down before moving onto the next.
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Flatting Tutorial

Breaking down the rest of the main back- but you do need to get it right, and get all
ground mountain, tunnel, and broken gate.  the different parts separated. Speed comes
Not the most exciting work in the world, with practice.
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Flatting Tutorial

The last few
things are picked out
- the rope, ground. I
give the panel a last
look over, turning
the lineart channel
off and on again to
make sure I have all
the areas properly
separated on this
panel.

Nowcomesthe fun
part - breaking down
the character(s) on
a page. I try to pick
out parts so that I
have to make as few
selections as possi-
ble. Lara has 26 dif-
ferent parts that all
need to be separated,
but I can get them all
separated by just se-
lecting 11 different
parts.

I start with the fur
trim. By doing this
first, I automatically
separate her boots
from the rest of her.




Flatting Tutorial

Next I pick out all
the skin. This also
ends up separat-
ing her gloves, lips,
glasses and bracelet.

You can make
pretty complex se-
lections with the
lasso tool - her
face, with the lips
and glasses were all
separated using one
single selection.

Sounds  impos-
sible? I'll show you
how.

At the bottom 1is a
screen capture that
shows the path of
the lasso tool.

I started near the
top, looped around
one lens, followed
down to the lips,
looped around them,
moved up to the
other lens, looped
around it before fol-
lowing her forehead
and closing off the
selection.

Much faster than
selecting her entire
face, and cutting
out those parts from
your selection.
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I'pop outher pants,
which also separates
her holsters from ev-
erything else.

Smart selections
like this will speed
up things tremen-
dously, rather than
starting from the
outside and moving
along one section at
a time.

Separate the hair,
and rope. Techni-
cally, everything is
all separated, but
too many different
things are the same
colors. So I grab
the Bucket tool, turn
Contiguous on, and
start filling things
with different col-
ors.

Having Contigu-
ous on means [ don’t
have to worry about
the Bucket tool fill-
ing everything on
the page that is the
same color as what I
select, with the new
color.




Flatting Tutorial

Now she’s all separated properly, with different colors defining different things. Now that
I’ve set up colors for her clothing etc., I can just eyedrop them to use on the last panel.

This is where dual monitors, or a single large monitor can come in handy. You can have
a second copy of the file open, zoomed out all the way so you can pick up colors from it,
and apply it where you are zoomed in on your main window. This way you don’t have to
zoom out again to pick up the color, or scroll around the screen to find it, and you’ll also
keep your colors consistent throughout the page.
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Flatting Tutorial

Now I start on the last panel, selecting
and filling the ground behind Lara (bottom).
After that, I select and fill the rope with col-
or (right).

Background is all done, now I can break
down Lara.
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Flatting Tutorial

As usual, I try to make smart selections so
I don’t have to select every last little bit with
the Lasso tool.

Separating her pants also breaks apart the
fur trim on her boots, and one holster (top
left).

Separating the fur trim doesn’t break apart
anything extra, but it sets the stage for the
next set of selections (top right)

Picking out the skin separates her lips,
and the glove on her left hand (left).
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Flatting Tutorial

Breaking out the holsters separates one of
the guns (top left).

Separating the gloves also breaks out the
bracelet (above).

Now I start in on the face - popping out
the lenses on her glasses (left), then I pop
out her hair which also separates her eyes.
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Flatting Tutorial

Zoom in, pop out the frames of the glass-
es and the iris’ of her eyes (top left); fill the
whites of her eyes (top right); separate the
skin on her chest from the skin of her face.
Lastly, I fill that stray hair I missed earlier,
below her jaw (right).
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Flatting Tutorial

Zoom out, and make sure I catch the rest
of the details - belt buckle, jacket button,
and the guns.

I start looking over the page again, zoom-
ing in and out making sure I haven’t missed
anything - such as the holster on her left hip,
in the top right panel - I missed that earlier,
thinking it was part of the background rock
scribbles (left)

Once I'm sure I have separated every-
thing, I double-click on the lineart channel
and change the opacity to 100%. Now the
page is all flatted, and ready for coloring
(next page).
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The Business of Flatting.

Flatting pages isn’t glorious work. You
will rarely see your name in the credits of
books you work on. You will almost never
get comps of books you flat (Comps are free
copies).

Compared to pencillers, inkers and col-
orists, the pay is pretty low. But it’s still a
business. No matter what your long term
goals are, it’s serious business.

I can’t tell you how much work I get from
colorist because “some flatter *&$red up”.
Either the unnamed flatter did a sloppy job,
didn’t do the job at all, forgot, got bored,
missed the deadline, decided they wanted
more money, etc., etc., etc.

The comics business is a small commu-
nity - everybody knows everybody! Doing
a poor job is a really fast way to get a bad
reputation that’s going to be hard to lose.

If you’re going to do the job, do it well.

With that in mind, here are a few tips.

Contact Information

Make sure you have phone numbers and
email addresses written down on paper. If
your email wipes out, or hard drive crashes,
you need to be able to call your colorist to let
them know you have a problem right away.
No one’s going to get mad if your computer
has suddenly died. But if you wait until the
last minute to let the colorist know you can’t
do the work, they’ll be pissed because they
could’ve spent the time to find someone
else. If you just have their email address....
you can’t get a hold of them.

Know your Deadlines.

Most times 24 hour or less turnaround is
expected. Sometimes you get pages for sev-
eral different books at once. Make sure you
know which ones are due first, and when.

Don’t take on work if you’re not sure
you can meet the deadline. Take only work

Flatting Tutorial

you KNOW you can get done in the allotted
time. People will respect you for saying you
can’t get the work done when they need it,
if you tell them up front. People appreciate
honesty, even if you are unable to help them
with flats.

They’ll be able to look for someone else
right away, rather than finding out they need
to look for another flatter at the last minute,
the night before the last four pages are due
in to the publisher.

Keep Records.

Keep careful track of the work you do,
on paper! Once again, if your computer
crashes or file corrupts, and you kept every-
thing on the computer, you’ve got no way
to figure out what you’re owed for. I have
tracking sheets that list: Title, Issue & page
#; Page Rate; Date completed; and Colorist
I did the work for. After each flat is done, I
fill in the information on the tracking sheet
while the file is transferring. At the end of
every workday, I enter the information onto
a spreadsheet program, which is backed up
every week.

I use this spreadsheet to keep track of all
the work I’ve done, what is owed, what’s
been paid for, and my total earnings by the
week, month, quarter and year.

This also simplifies things come tax time
- I know exactly what I’ve earned, when,
and from whom.

Invoices

Check and see how colorists want in-
voices. Some will accept simple e-mail in-
voices, others want hard copy invoices snail
mailed. Some require specific information
(Tax Identification, Social Security, etc) list-
ed on the invoice. Always make sure your
name, full address, phone number, email ad-
dress, date, amount owed, and itemized list
of work done are on the invoice, plus any
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other information they ask for.

E-Mail

I have every business email sent to me
on CD from the last 7 years. Always keep
a copy of everything. This can protect you
in the event of mistakes. For instance, if
you’re given a page rate of $20 per page,
and the colorist tells you “I thought I said
$15 per page”, you can send them a copy of
the email confirming they said “$20.”

Page Rates

Before starting any work, make sure you
know what you’re getting paid, when you
can expect to be paid, and how you’re going
to be paid. Usually it’s 30-45 days after you
turn in the last page of a book, but some-
times it takes longer. Many colorists pay

via Paypal, and if you can, get paid through
Paypal. It’s much faster than waiting for a
check in the mail, it won’t bounce, and your
bank won’t hold the funds for 30 days like
they will a check, especially if that check is
from someone outside your country.

If you’re unfamiliar with the book, ask to
see samples of the pages so you know what
you’re in for. Don’t get stuck taking really
complicated, detailed bo ok where you’re
going to spend hours-and-hours-and-hours
on each page for only $5 a page. You’ll end
up kicking yourself for it.

Page rates for flatting will vary, from book
to book and colorist to colorist.

Average rates are $15 US a page. If the
book is for a smaller publisher, it may be
less, as the colorist’s page rate is likely low-
er.

If you found this tutorial useful, consider
making a donation via Paypal. Click the
button below and make a contribution!

DONATETOOAYY

PayPal visa &
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